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Preface 

 

This preface contains the following topics: 

 About this Guide 

 Audience 

 Document Conventions 

About this Guide 

This guide describes how to use the Kaltura Video Extension for SharePoint 2013, for both SharePoint 
2013 (On-Premise) deployed within your organization’s environment and for SharePoint 2013 in the MS 
Office 365 cloud. We’ve designed the solution to fit naturally into the SharePoint environment. All of the 
instructions are standard SharePoint actions. If you are a SharePoint designer or user, this solution and 
these instructions are very similar to the other solutions you are familiar with. Some features may not be 
available for Office 365 users due to SharePoint limitations and are indicated as so.  

 

 

NOTE: Please refer to the official and latest product release notes for last-minute updates. 

Technical support may be obtained directly from: Kaltura Customer Care. 

Contact Us: 

Please send your documentation-related comments and feedback or report mistakes to 
knowledge@kaltura.com. We are committed to improving our documentation and your feedback is 
important to us.  

Audience 

This guide is intended for SharePoint site designers, site owners and site users. 

Document Conventions 

Kaltura uses the following admonitions: 

 Note 

 Workflow 

 

 

NOTE: Identifies important information that contains helpful suggestions. 

 

 

Workflow: Provides workflow information. 

1. Step 1 

2. Step 2 

mailto:customercare@kaltura.com
mailto:knowledge@kaltura.com
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About the Screenshots 

The Kaltura Video Extension for SharePoint 2013 implements a responsive web design for optimal user 
experience across all devices. The user interface displays differently on different devices and available 
screen sizes. 

The screenshots in this guide were taken on a desktop computer, and the user interface may differ 
somewhat on different devices. The functionality remains the same. 
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SECTION 1  

Introduction to the Kaltura Video Extension 
for SharePoint 2013 

Kaltura Video Extension for SharePoint 2013 allows end-users (employees, students and others) to easily 
upload and create video content directly from within SharePoint without worrying about file size limitations 
or various video formats. Users can then easily embed their contributed videos inside SharePoint pages 
and workflows, create playlists, make their video searchable and social, and even reuse their videos 
beyond SharePoint in other applications (CMS, LMS, corporate video portals, etc.). In addition to on-
demand video, Kaltura allows you to engage employees by streaming live events directly within 
SharePoint. This translates into time and money saved for your organization, improved user engagement, 
creativity and learning results, as well as ease of use for all users. 

Kaltura’s Video Extension for SharePoint 2013 makes it easy to add the robust capabilities of Kaltura's 
online video platform to any SharePoint site. The package was developed specifically for SharePoint and 
integrates with other features and modules so that users can upload and embed media easily. 

Hosting and Deployment Options 

Kaltura offers the most flexible deployment options in the industry. Kaltura’s Video Extension for 
SharePoint 2013 seamlessly integrates the Kaltura Video Platform within an organization’s self-hosted 
(On-Premise) SharePoint installation or on a SharePoint Online (part of Office 365 suite) cloud 
implementation. 

More specifically, the rich-media content, its metadata as well as the specific publishing settings and 
usage information that are stored in the Kaltura system, can be hosted by Kaltura (Kaltura SaaS), with no 
need for a CDN relationship or video streaming solution. It can also be hosted by customers as part of a 
self-hosted deployment of Kaltura’s video platform (Kaltura On-Prem™) and Behind-the-Firewall Delivery 
solution or as a hybrid model that leverages the best from both worlds. In addition Kaltura’s open 
architecture allows you to integrate with any third party CDN or eCDN. 

Pre-requisites 

The information in this guide assumes that the Kaltura Video Extension for SharePoint 2013 software has 
been installed and configured on your system by a SharePoint administrator. If the solution has not been 
installed, please refer to the Kaltura Video Extension for SharePoint 2013 Deployment Guide for On-
Premise or the Kaltura Video Extension for SharePoint 2013 Deployment Guide for MS Office 365 to 
install and configure the solution before using it. 

Main Features and Tools 

Upload and Record 

 Easy Video Uploading - Upload any type of media (video, audio, images, presentations) using a 
simple interface. 

 Create webcam videos - Welcome messages, introductions, assignment instructions, simple 

http://knowledge.kaltura.com/node/1381/attachment/field_media
http://knowledge.kaltura.com/node/1381/attachment/field_media
http://knowledge.kaltura.com/node/1345/attachment/field_media
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demonstrations, and other webcam media. 

 Screen Recording – Easily record the screen, along with audio and webcam feeds, to create 
and publish screencasts. Users can record and share lectures, presentations, software tutorials, 
and additional screencasts. 

 Video Presentations – Create a synchronized view of a document and a video. Provision video 
presentations in My Media to simplify the process of adding presentations.  

 Live Event – Create and view live events. 

 YouTube - Add YouTube video content and metadata. 

Organize, Publish 

Publishing is the process of taking private content from My Media and publishing it to a Media Gallery or 
posting it in an inline text. 

 My Media – Upload, manage, assign, and share content (based on permissions) with a private 
media library for each SharePoint user. 

 Media Gallery – Search or view rich media assigned to a site or sub-site if you are a member. 
Media can be added by users, with an option for contribution’s moderation. 

 Add Media as App or Web Part - Intuitively use App Parts or Web Parts without time-
consuming training, to add media into your pages. 

View and Interact 

 The Kaltura Player: 

o Customize the player - functionality, features and display. 

o Configure once use everywhere - mobile, tablet, PC, TV. 

o Files are transcoded for Web, HD, or Mobile Delivery across various devices and platforms. 
Player auto detects device and platform and adjusts the playback using adaptive bitrate 
technology. 

o Playback supporting both Flash and HTML5 for mobile, with automated fall back. 

o Accessibility - Supports playback with ADA/508 compliant player. 

 Responsive Design: Automatically adjusts site layout to the screen size and device to provide 
optimal mobile device support. 

 Captions - Upload multi-lingual captions to reach international, multi-lingual, and hearing-
impaired audiences while also enabling in-video search within the captions. 

 Comments - Boost online conversations and user engagement by allowing users to comment on 
videos. 

 Browse, Search and Embed - Quickly find and embed videos based on metadata (name, 
description, tags, categories) 

 In-video search – Upload captions and then search for every spoken word. Search results allow 
skipping directly to the relevant part in the video. In-video search available within an entry or 
across videos in the Media Gallery/My Media Gallery. 

 Analytics – Managers can view gallery-level reports for video engagement: 

o Which videos are users watching the most? 

o Which users contribute the most videos? 

o Which users watch the most videos? 

The Kaltura Application Framework (KAF) Admin 



Introduction to the Kaltura Video Extension for SharePoint 2013 

Kaltura Video Extension for SharePoint 2013 User Guide 9 

Console  

The Kaltura Video Extension for SharePoint 2013 is implemented on top of the Kaltura Application 
Framework (KAF), a feature rich framework that allows flexible and streamlined integration of Kaltura’s 
Video Extension and products into 3rd party applications such as SharePoint. KAF is hosted and served 
directly from the Kaltura cloud servers and once integrated into your SharePoint environment, presents 
different video components and workflows to users.  

At the backend, the Kaltura Application Framework provides a flexible and extensible administration 
panel, called “KAF Admin Console”. The KAF Admin Console offers full control over the user experience 
and when interacting with videos inside SharePoint. Nearly all configuration aspects of the Kaltura Video 
Extension for SharePoint 2013 are configured through the KAF Admin Console. 
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SECTION 2  

Embedding Kaltura Views (Widgets) in 
SharePoint 2013 Pages 

 

Targeted for - Site designers and members 

Applicable for - SharePoint On-Premise and SharePoint for MS Office 365 

Description – Use to add or edit a SharePoint page, then add one or more Kaltura web-parts or app-
parts to the page. 

Adding or Editing a SharePoint Page 
Kaltura web-parts and app-parts are embedded within SharePoint pages like any other SharePoint 
content.  

 To add a SharePoint page 

 Click on the gear icon (appears on the top corner of the site) and choose “Add a page” or instead 
navigate to “Site Contents if your SharePoint site template does not have this option.  

 Choose a page’s library and add a new page.  

 

 You may also add a web part or layout page to insert a Kaltura Widget.  

 To edit an existing SharePoint page 
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 Navigate to the page. 

 Click on the gear icon (appears on the top corner of the site) and choose “Edit page” or instead 
navigate to “Site Contents if your SharePoint site template does not have this option, or  

click on the top bar (ribbon) link Page and then click Edit to get into the edit page screen. 

 

Adding Kaltura Widgets or Kaltura App Parts to the 
SharePoint Page. 

 To insert Kaltura Widgets into the SharePoint page (On-Premise) 

 In Edit-page window, click on the Insert tab and choose Web Part.  

 Find the category “Kaltura” on the list and click.  

The Kaltura web-parts are displayed. 

  Click on the items to embed them within the page. 

The following web-parts are available for your selection: 

o Kaltura Media Gallery – Widget that displays all the media items that belong to the current 
site. 

o Kaltura My Media –Widget that displays all media items owned by the user, typically these 
are media items that the user has uploaded. 

o Kaltura Browse Search and Embed - Widget that allows you to embed specific media in a 
page. Users that visit the page see the chosen video displayed. You may place one or more 
‘Browse Search and Embed’ parts in a page in case you want to embed multiple media items 
in a single page.  

 

NOTE: For documentation purposes the Kaltura App Parts are referred to using their 
Kaltura default names. These App Parts may have different names if the SharePoint 
application was customized by your administrator. 
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 To insert Kaltura App Parts into the SharePoint page (MS Office 365) 

 In the Edit-page window, click on the Insert tab and click App Part.  

 Find the category “Kaltura” on the list and click.  

The Kaltura App Parts are displayed. 

  Click on the items to embed them within the page. 

The following app-parts are available for your selection 

o Kaltura Media Gallery – Widget that displays all the media items that belong to the current 
site. 

o Kaltura My Media –Widget that displays all media items owned by the user, typically these 
are media items that the user has uploaded. 

o Kaltura Browse Search and Embed - Widget that allows you to embed specific media in a 
page. Users that visit the page see the chosen video displayed. You may place one or more 
‘Browse Search and Embed’ parts in a page to embed multiple media items in a single page.  

 

NOTE: For documentation purposes the Kaltura App Parts are referred to using their 
Kaltura default names. These App Parts may have different names if the SharePoint 
application was customized by your administrator. 
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Add the Full-Screen Enabler Web Part  

Due to a SharePoint limitation, MS Office 365 Apps cannot get maximized over the entire screen. Users 
may not be able to watch media in full-screen mode, when launched from Kaltura player. To overcome 
this limitation add the Full Screen Enabler Web Part. 

 To add the Full Screen Enabler Web Part 

 In the Edit-page window, click on the Insert tab and click Web Part.  

 Locate and click on the group “Kaltura” and then select the web-part “Kaltura Full-Screen 
Enabler”. 

 Drag the Kaltura Full-Screen Enabler” Web Part to any page where you want to enable full-
screen playback.  

The Kaltura Full-Screen Enabler web part has no interface. Its purpose is to allow you play Kaltura items 

in full-screen once you click the ‘full screen’ button on the Kaltura player 
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 To hide the Kaltura Full-Screen Enabler web-part  

 Edit the web-part properties and set an empty title. 

 



 

Kaltura Video Extension for SharePoint 2013 User Guide 15 

SECTION 3  

Configuring Kaltura Views (Widgets)  

 

Targeted for - Site designers and members 

Applicable for - SharePoint On-Premise and SharePoint Online for MS Office 365 

Description – Use to configure a Kaltura widget (Kaltura web-part or Kaltura app-part) in a page using 
the SharePoint properties pane 

 To configure Kaltura Views (Widgets) 

 Navigate to the page where you want to edit the Kaltura Widget properties and switch to edit 
mode. See Adding or Editing a SharePoint Page. 

 Click Edit on the widget you want to edit.  

Every web-part or app-part has an Actions menu (arrow) on the side.  

 Select Edit Web Part or Edit App Part. 

 

The properties pane opens on the side.  

 Use the Properties section to edit various user interface properties for example, Widget Title, the 
Widget Size and others.  
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 Click Save to Save the Settings form. 

 

NOTE: The Kaltura Widget is responsive to its allocated size. Its elements on the screen 
reorganize according to the allocated size. 
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SECTION 4  

Optional: Configuring Media Search  

 

Targeted for – Site collection administrators 

Applicable for - SharePoint On-Premise only. Not applicable for the SharePoint for MS Office 365 
environment. 

Description – Use to customize the media items look and feel within the search result, after applying the 
search customization media items will have unique logo and hover panel for preview. 

See the Configure Media Search section in the Kaltura Video Extension for SharePoint 2013 Deployment 
Guide for On-Premise. 

http://knowledge.kaltura.com/node/1381/attachment/field_media
http://knowledge.kaltura.com/node/1381/attachment/field_media
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SECTION 5  

Creating and Viewing Media  

 

Targeted for - SharePoint users (typically members of the SharePoint groups: “Site Members”, “Site 
Contributors” and “Site Visitors”) 

Applicable for - SharePoint On-Premise and SharePoint Online for MS Office 365 

Description – How to view and upload media to SharePoint. When using the Kaltura Video Extension for 
SharePoint - the experience is almost identical to other Kaltura applications.  

Where to Add Content 

You will need to navigate to a SharePoint page where you or the site designer placed the Kaltura widgets. 
If you are not certain where the page containing the Kaltura Widgets is, ask the site designer to share the 
page with you and to create a link to the page in the navigation menu. If you are a member of the site, 
you may add Kaltura widgets to pages. See Adding or Editing a SharePoint Page. You may find any of 
the following Kaltura widgets (views) configured SharePoint pages: 

 Kaltura Media Gallery – This widget displays all the media items that belong to the current site. 

 Kaltura My Media – This widget displays all the media items that you uploaded. 

 Kaltura Browse Search and Embed - This widget allows you to play a specific media item  

Using any of this widgets, you can upload new media items or click on any media item to watch its’ 
content. 
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For example: Media gallery widget in a SharePoint page. Click “Add Media” to add new items, or click on 
existing items to play the content. 

You can create media from My Media and in Media Galleries by: 

 Uploading media 

 Recording from webcam 

 Adding a Presentation 

 Recording your screen 

 

NOTE: The tools used to create media may be enabled or disabled by the Kaltura Admin 
in the KAF Admin Console. 

 

 

Uploading Media 

You can upload media from the My Media or Media Gallery interface via the Add New menu.  

 

 To upload media from your desktop 

 Select Media Upload from the Add New dropdown menu. 

The Upload Media page is displayed. 

 

 

 Click Choose a file to upload. 

 In the Select file to upload window, select a media file to upload and click Open. 

 While the file is uploading, on the Upload Media page you can: 

o Enter metadata information about the media and click Save. 

o Mandatory fields are marked with an asterisk. 

o Click Cancel to cancel the upload. 

o Click Choose another file to upload additional files. 

 To view the media page when uploading is complete, select the media from My Media. 
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Video Status after Upload 

After a video is uploaded, it is converted for optimal playback. You cannot preview or publish a video 
during conversion. If media is waiting for moderation, you cannot preview or publish it until it is approved. 
You can edit media information during conversion and while waiting for moderation. 

Recording from Webcam 

Use the Record from Webcam feature to create webcam media such as welcome messages, 
introductions, assignment instructions, simple demonstrations, and other recordings. 

 To record from a webcam 

 Select Webcam Recording from the Add New dropdown menu 

 

The Record from Webcam page is displayed. 

 In the Record from Webcam window, click Allow if a Flash player message is displayed. 
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 In the Record from Webcam window, click anywhere in the recording area to start recording. Click 
anywhere in the recording area to stop recording. 

 Enter information about the media and click Save.  

Adding a Video Presentation  

A video presentation consists of a document and a video file, synchronized together, Document formats 
supported are: ppt/pptx, pdf, doc/ docx, xls/ xlsx. 

After a document is uploaded, it is converted to a format suitable for display in the presentation. This may 
take a few minutes. After your content is ready it is displayed in the document list. 

The video presentation feature enables content creators to synchronize video and specific slides in a 
slideshow or document and share the synchronized presentation. 

 

 

Basic workflow to synchronize the display of media and document files: 

1. Add a presentation file 

2. Select a media file. 

3. Upload a presentation (document), if you have previously not uploaded one. (The 
presentation file is required in step #3).  

4. Select a document file. 

5. Add sync points to synchronize the document with the media.  

The Kaltura Video Presentation Widget 
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The Kaltura Video Presentation Widget allows the side-by-side, synchronized display of media and 
document files to end users.  

 To create a video presentation 

 Select Video Presentation from the Add New dropdown menu. 

The Add Video Presentation page is displayed. 

 

 On the Add Video Presentation page, click Upload Document. This step is required if you did not 
upload the presentation before. After the file is uploaded it is converted and will be used when 
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selecting the media and document to be synchronized. 

 In the Upload Document window, click Browse your desktop. 

 In the Select file to upload window, select a document or presentation file to upload and click 
Open. 

 In the Upload Document window, enter information about the document and click Close. 

 

 In the Upload Document window, click Back to the video presentation creation flow (step 1) to 
continue creating a video presentation. 

 

NOTE: After a document is uploaded, it is optimized for display in the presentation. You 
cannot use a document in a video presentation until optimization is complete. 

 To select and synchronize files  

1. On the Add Video Presentation page, select a media item from a list of available video and audio 
items, and click Next. 
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2. On the Add Video Presentation page, select an item from a list of available documents and 
presentations, and click Next to create the video presentation. 

 

3. In the Edit Media window, synchronize the media and slides. 
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4. To start synchronizing the media with the slides, click Play in the media player.  

5. When you reach a point that you want to synchronize: 

a. Click the player to pause the playback. 

b. Hover over the video to display the thumbnail carousel. 

c. In the thumbnail carousel, select the slide to synchronize with the point where the playback 
paused, and click + Sync Video/Slide. 

 

d. Click Play in the media player to continue synchronizing the playback with the slides. 

e. Add and remove sync points as needed, and click Save. 

6. In the Edit Media window, enter information about the video presentation and click Save. . 
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 To start synchronizing the media with the slides, click Play in the media player.  

 When you reach a point that you want to synchronize: 

a. Click the player to pause the playback. 

b. Hover over the video to display the thumbnail carousel. 

c. In the thumbnail carousel, select the slide to synchronize with the point where the playback 
paused, and click + Sync Video/Slide. 

 

d. Click Play in the media player to continue synchronizing the playback with the slides. 

e. Add and remove sync points as needed, and click Save. 

f. In the Edit Media window, enter information about the video presentation and click Save.  

Recording Your Screen  

The following lists the basic workflow of how to record your screen:  

 

 

Workflow: 

1. Select the Screen Recording option. 

2. Launch the Screen Recorder. 

3. Select the options and area to capture, and start recording. 

4. After recording, review the results and upload. 

5. After uploading, enter metadata. 

 To record your screen 

 Select Screen Recording from the Add New dropdown menu. The Screen Recording page is 
displayed. 
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 In the Screen Recording window, click Launch the screen recorder.  

 

 In the Screen Recorder, follow the instructions to record your screen: 

a. Drag and resize the frame to define the screen area to record and enter Alt-P or click the 
Record button to begin recording. 

b. Toggle Alt-P or the Record/Pause button to pause and continue recording. 
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 Click Done to finish recording. 

 

 Review your recording and click Upload. 
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When the upload is complete, click Close. 
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SECTION 6  

Managing Your Media  

Your My Media page lists the media that you created. In addition to all normal interactions with media, as 
described in Creating and Viewing Media when you open a media page, you can: 

 Edit media 

 Select a thumbnail 

 Create a Clip 

 Trim a Video 

 Upload and manage captions 

 Publish media items 

 Disable or close comments  

 

NOTE: The features used to manage media may be enabled or disabled by the Kaltura 
admin in the KAF Admin Console.  

My Media is a widget or an App-part (depends on the SharePoint deployment) and it can be accessed 
from the link or page the site collection admin or any specific site admin added it to. 

 

Editing Media 

In the Edit Media page, you can: 
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 Edit information about the media. Modify tags. The Tags field automatically completes values 
from tags that already exist in your application and consolidate taxonomy and improve 
discoverability of your content. 

 Click Delete media to delete an entry. 

 Click Create Clip to create a clip. See Creating a Video Clip. 

 Access other Editing tabs. 

 Add attachments 

 To edit media  

 On your My Media page, click Edit for the media you want to edit. 

 

The Edit Media page opens with editing tabs. The editing tabs displayed are dependent on your 
KAF admin configuration. 
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Enabling Clipping 

Use the Options tab in the Edit page to manage clipping and to manage comments. 

 

 To allow other users to create clips from an entry 

 To allow other users to create clips of a video entry, go to the entry Edit Page in My Media.  

 Select the Options tab and then check the “Enable everyone to create clips from this video” 
checkbox. 
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Disabling and Closing Comments 

For each of your media items, you can:  

 Disable the comment feature. 

 Prevent additional comments. 

 To disable comments on a media item 

 On your My Media page click Edit for the video you want to edit. 

 Select the Options tab and select the Disable comments for this media checkbox. 

 The Comments tab is not displayed on the media page. 

 
 

 

NOTE: Comments that were entered before you disable the comment feature are re 
displayed if you re enable comments. 

 To prevent additional comments on a media item 

 On your My Media page click Edit next to the video you want to edit. 

 Select the Options tab and select the Close discussion checkbox. 

On the Comments tab of the media page, Comments closed is displayed and the Add a Comment field is 
not displayed. 

Uploading and Managing Captions 

You can upload caption files for your media items and manage the captions.  

 

NOTE: Only video items can have captions. 

Uploading Captions 

 To upload captions 

 Click Edit next to the video you want to add captions to. 
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 Select the Captions tab and click Upload captions file. 

 

 Click Browse and select an SRT or DFXP caption file. 

 Select the caption language. 

 Enter a label to display for the file in the caption selector. 

The caption selector displays caption options in the media player. 

 Click Save to upload the file. 

The file is added to a table on the media page's Captions tab. 

 

 

NOTE: To upload another file, click Upload captions file again and repeat step Error! 
eference source not found.. 

Managing Captions 

After you upload captions for a video, in the caption table you can: 

 Modify the caption language or label. 

 Change the default caption file. 

 Delete a caption file. 

 Download a caption file. 

  To modify the language or the caption selector label 

 On your My Media page, select the video and click Edit. 

 Open the Captions tab to display the caption table. 

 In the caption table, click Change and do the following: 



Managing Your Media 

Kaltura Video Extension for SharePoint 2013 User Guide 35 

o To change the language, select a new language in the Language column. 

o To change the label, enter new text in the Label column. 

 Click the disk icon to update the values. 

 To change the caption file used by default in the media player 

 Do one of the following on your My Media page: 

o Expand a video thumbnail entry to display the Edit button and click Edit. 

o Click the thumbnail or title of a video entry to open the video page.  

 Under the Actions drop down in the video page, click Edit. 

 Open the Captions tab to display the caption table. 

 In the caption table, click on the checkmark icon in the right column of a caption row to Set as 
default. 

 To delete a caption file 

 Do one of the following on your My Media page: 

o Expand a video thumbnail entry to display the Edit button and click Edit. 

o Click the thumbnail or title of a video entry to open the video page.  

 Under the Actions drop down in the video page, click Edit. 

 Open the Captions tab to display the caption table. 

 In the caption table, click on the “x” icon to Delete. 

 In the Confirm Remove window, click Yes to remove the caption file. 

 To download a caption file 

 Select My Media from the user menu. 

 Select a video and click Edit. 

 Click the Captions tab to display the caption table. 

 Click the Download icon. 

 
 

The captions file is downloaded 

Creating a Video Clip 

When clipping and trimming are enabled on the account and for the specific media, you can create clips 
from existing videos. Each clip becomes its own media entry. The clipping tool enables you to edit your 
videos visually or by setting the start time and end time of your clip. 

Clipping creates a new entry from an existing entry and allows you to specify the start and end time for 
the new entry. For example you can clip an entry that can be used to create a 2 minute intro video to a 
long lecture, or clip part of an entry, such as homework assignments. You can also clip a long lecture to 
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several shorter clips divided by subjects. 

Entries can be clipped by the media entry owner in My Media. 

 To create a video clip in My Media 

 Select My Media and then click Edit next to the entry you want to use to create a clip. 

 In the Edit Media window select Create Clip.  

 

or click on the entry and select Create Clip from the Actions drop down menu. 

 

 

 Use the trimming timeline or enter exact start and end times. 
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 Press Play and click Set Starting Point of the video clip or alternatively, select the Start Time. 

 Select Set Ending Point as the end point of the video clip, or alternatively select the End Time. 

 Click Create Clip. 

The clipped content appears in My Media as a new entry. Media owners can define the videos that other 
users can generate clips from. 

 To allow other users to create clips from an entry 

 To allow other users to create clips of a video entry, go to the entry Edit Page in My Media and 
under Options  Clipping check the “Everyone” checkbox. 

 

 

Selecting a Thumbnail  

There are three options to select a thumbnail for your content: 

 Upload a thumbnail from your desktop and use it as the default thumbnail. 

 Use the player to select the frame you want to use as your default thumbnail and then click on 
the Capture button. 

 Select one thumbnail from ten automatically generated thumbnails of the selected video and set 
it as the default thumbnail. 
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 To upload a thumbnail from your desktop 

 Select My Media and then click Edit next to the entry you want to add a thumbnail to. 

 In the Edit Media window select the Thumbnails tab.  

 Click Upload Thumbnail. 

 Upload a file from your desktop and click Open. 

 To grab a frame from the content as a thumbnail 

 Select My Media and then click Edit next to the entry you want to add a thumbnail to. 

 In the Edit Media window select the Thumbnails tab.  

 Select the Thumbnails tab and click Play. 

 Click Capture at the frame that you want to use as a thumbnail. 

The captured frame is saved automatically and used for the thumbnail. 

 To select an automatically generated thumbnails  

 Select My Media and then click Edit next to the entry you want to add a thumbnail to. 

 In the Edit Media window select the Thumbnails tab.  

 Click Automatically Generate. 
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You can also download the selected thumbnail by clicking the download tab. 

 To download and save a thumbnail 

 Select My Media and then click Edit next to the entry you want to add a thumbnail to. 

 In the Edit Media window select the Thumbnails tab.  

 Click Download. 

 Save your image. 
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Trimming a Video Clip 

Trimming must be enabled on your account to use this feature. 

 To trim a media entry 

 Select My Media and then click Edit next to the entry you want to trim, 

 In the Edit Media window select the Trim Video tab.  

 Use the trimming timeline or enter exact start and end times. 

 Press Play and click Set Starting Point of the video clip or alternatively, select the start time. 

 Select Set Ending Point as the end point of the video clip, or alternatively select the end time. 

 Click Trim video. 

The trimmed video appears in My Media. 

Adding an Attachment to a Video 

You can attach files to you media. Media viewers may download the file before, during or after viewing 
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the media.  This feature must be enabled by your administrator. 

 To add an attachment to a media entry 

 Select My Media and then click Edit next to the entry you want to trim, 

 In the Edit Media window select the Attachment tab.  

 

 Click Upload file. The Upload window is displayed. 

 

 Provide descriptive information about the attachment (optional) and click Select File. 

 Select a file to attach and click Open. 

The file is saved as attachment to your media file. 
Use the editing options /icons in the Actions column to change delete or download the attachment 
file. 

 

Replacing a Video 

You can replace media, and retain the entry’s metadata, URL and analytics. Only video entries can be 
replaced. The time-based metadata on the entry is kept place, however it most probably will be out of 
sync with the new media. The time based metadata should be manually adjusted.  

 To replace a media entry 
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 Select My Media and then click Edit next to the entry you want to trim, 

 In the Edit Media window select the Replace Video tab. 

  

 

 Click Choose a file to upload and select the replacement file, 

 After the upload is complete either click Approve or Cancel Replacement determine your choice. 

Trimming a Video 

Trimming must be enabled on your account to use this feature. You can trim out parts of video from the 
Edit Media page. The trimming tool enables you to edit your videos visually by setting the start time and 
end time of your media. 

Sometimes, you may want to trim the start and/or end of a video to remove redundant parts. Trimming is 
performed on the source media, modifying that video permanently. 

Trimming is only available to the owner of the video and is only accessible in My Media. 

 

 To trim a media entry 

 Select My Media and then click Edit next to the entry you want to trim, 

 In the Edit Media window select the Trim Video tab.  

 Use the trimming timeline or enter exact start and end times. 

 Press Play and click Set Starting Point of the video clip or alternatively, select the start time. 

 Select Set Ending Point as the end point of the video clip, or alternatively select the end time. 



Managing Your Media 

Kaltura Video Extension for SharePoint 2013 User Guide 43 

 Click Trim video. 

The trimmed video appears in My Media.  

Publishing Media 

By default, all media that you upload is private. You can access private media on your My Media page.  

 

 

You can publish media to one or more Media galleries only from within the Media Gallery itself. It can be 
done only when file conversion is complete and the media is not waiting for moderation 

 
If a Media Gallery is moderated by a moderator, the media should appear as Pending in My 
Media until the moderator approves the content. A moderator may reject the media from being 
included in the Media Gallery. In this case, the media appears as Rejected in My Media. If the 
Media Gallery is not moderated, no label will appear for the media, indicating that the media is 
published. 
Users may have their uploaded content pending until approved by the moderators. 
 

    

Private entry – not 
published to any Media 
Gallery 

Pending – published to 
one or more Media 
Galleries and waiting 
for approval 

Rejected – published to 
one or more Media 
Galleries but was 
rejected 

Published (no label) – 
appears in at least one 
Media Gallery 

Disabling and Closing Comments 
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For each of your media items, you can:  

 Disable the comment feature. 

 Prevent additional comments. 

 To disable comments on a media item 

 On your My Media page click Edit for the video you want to edit. 

 Select the Options tab and select the Disable comments for this media checkbox. 

 

 

 

NOTE: Comments that were entered before you disable the comment feature are 
re-displayed if you re-enable comments. 

 To prevent additional comments on a media item 

 On your My Media page click Edit next to the video you want to edit. 

 Open the Options tab and select the Close discussion checkbox. 

 On the Comments tab of the media page, Discussion is closed is displayed and the “Add a 
Comment” text box is not displayed.  

  



Using the Kaltura Video Extension to Search for Media 

Kaltura Video Extension for SharePoint 2013 User Guide 45 

SECTION 7  

Using the Kaltura Video Extension to Search 
for Media  

 

Targeted for: SharePoint users (typically members of the SharePoint groups: “Site Members”, “Site 
Contributors” and “Site Visitors”) 

Applicable for: SharePoint On-Premise only. Not applicable for the SharePoint for MS Office 365 
environment. 

Description: Using the SharePoint Search mechanism. Kaltura media items behave similarly to any other 
SharePoint information and support all the typical search tools that SharePoint offers. 

 

 

NOTE: The Search interface varies in different companies and is subject to different 
customizations. The explanations in this guide refers to the built-in SharePoint search 
user interface. If the search components are customized in your organization, please 
consult your site administrator. 

Searching for media items, is similar to all other content search in SharePoint.  

 To search for media content 

 Type the phrase you wish to search for in the search box and submit.  

Typically, SharePoint sites have a search box at the top corner, however the site designer may place 
search boxes in different places or create a Search site with an enhanced search experience.  

After invoking a search, you are presented with the search result page. If your search yielded results, they 
are presented on the screen. You may see various types of content in the result screen, for example: 
Word or PowerPoint documents, discussions and other SharePoint information. The following screen 
illustrates the Search results in SharePoint where Kaltura items are indicated with the Kaltura icon 
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You may also filter your content to view only media items. See To filter the search results.. 

 To play media items that appear in the search result 

 Click on the title of the item. Alternatively, you may hover the item, a popup panel appears. 

 Click the “Play Media” button within the panel. 

 

 To filter the search results 

You may use any of the following tools: 

 Refiners – Usually, SharePoint search result screens have a side panel with filtering elements, 
known as “Refiners”. Typically, at minimum, you’ll find a refiner that allows to filter by date and a 



Using the Kaltura Video Extension to Search for Media 

Kaltura Video Extension for SharePoint 2013 User Guide 47 

refiner that filters by the author. These refiners apply to Kaltura items as well and may be used to 
find the items you seek faster. 

You may add custom refiners that suit your business scenario, for example. For more information 
see How to add refiners to your search results page in SharePoint 2013.  
 
To add a custom refiner, as described in the article How to add refiners to your search results 
page in SharePoint 2013, you should choose the desired refinement fields within the ‘Refinement 
Panel web Part’ properties. Kaltura media items expose multiple fields which are listed in the 
“Available Refiners” list. The following list describes the meaning of each field: 

o KalTitle – the title of the media item 

o KalCreatedDate – the date when this media item was added 

o KalDescription – the description of this media item  

o KalModifiedDate – the date when this media was last modified 

o KalUserID – The user which created this media item 

 Verticals – On some SharePoint sites, the search result screen contains tabs that allow you to 
navigate between different types of items. These tabs are known as “verticals” - Everything, 
People, Conversations, etc.  

 

Your SharePoint site may contain a Kaltura vertical (Its existence depends on whether the site 
administrator or designer have configured the vertical.). You can click on the Kaltura link to direct 
you to a search result view that contains Kaltura media items only. By using this tool you can 
focus on media items only in your search. 
 
You may add custom verticals that suit your business scenario. For more information see How to 
add a custom search vertical to your search results page in SharePoint 2013 

http://blogs.technet.com/b/tothesharepoint/archive/2013/11/11/how-to-add-refiners-to-your-search-results-page-for-sharepoint-2013.aspx
http://blogs.technet.com/b/tothesharepoint/archive/2013/11/11/how-to-add-refiners-to-your-search-results-page-for-sharepoint-2013.aspx
http://blogs.technet.com/b/tothesharepoint/archive/2013/11/11/how-to-add-refiners-to-your-search-results-page-for-sharepoint-2013.aspx
http://blogs.technet.com/b/tothesharepoint/archive/2013/11/13/how-to-add-a-customized-search-vertical-to-your-search-results-page-in-sharepoint-2013.aspx
http://blogs.technet.com/b/tothesharepoint/archive/2013/11/13/how-to-add-a-customized-search-vertical-to-your-search-results-page-in-sharepoint-2013.aspx
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